Vivado Design Suite
Tutorial

Design Flows Overview

UG888 (v2013.3) October 2, 2013

& XILINX.



& XILINX.

The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products. To the
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL
WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in
contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to,
arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special,
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of
any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility
of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or
to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent.
Certain products are subject to the terms and conditions of the Limited Warranties which can be viewed at
http://www.xilinx.com/warranty.htm; IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx.
Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole
risk and liability for use of Xilinx products in Critical Applications: http://www.xilinx.com/warranty.htm#critapps.

Notice of Disclaimer

©Copyright 2012-2013 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated brands
included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective
owners.

Revision History

Date Version Revision

10/02/2013 2013.3 Minor editorial update.
06/19/2013 2013.2 Validated with release.
04/25/2013 2013.2 Minor editorial update.

03/20/2013 2013.2 Validated with release.



http://www.xilinx.com/warranty.htm
http://www.xilinx.com/warranty.htm#critapps

& XILINX.

Table of Contents

REVISION HISTOIY....ouiiiiiecieiieiei ettt 2
Vivado DESIgN FIOWS TULOTIA ......uucvuueeieneriieciieciiec it ssasessssesesesssestsse st s sssssssssss st s sssssssesssssssessssnessssnees 5
DESIGN FIOWS OVEIVIEW.......oeeeeeeriecieeieiisssiesie st sssssssssss s s sssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnnsens 5
Working in Project Mode and NON-Project MOde...........ooeireenreneineeeseiseseiesie s sssseseseees 5
USING Tl COMMEANTAS ...ttt ss bbb s 6
TUtOrial DESIGN DESCIIPTION ..ottt sttt nees 7
SOFtWAIE REQUITEIMENTS ...ttt ettt bbb asesnes 7
Hardware REQUITEMENTS ...ttt sttt bbb ssnsnes 8
Preparing the TUtorial DeSIGN FIlES........ ettt ss s sssssens 8
Lab 1: Using the NON-Project DESIGN FIOW .........ccureiciieceiieeeiiseesiseesssesssssssssssesssssessssesssssesssssssesssesesssnessssnessssnssess 9
Step 1: Examine the EXamPIE SCrPL ...ttt ssss s sss st sssssssssnsnns 9
Step 2: Starting Vivado with the EXample DeSIgN ... sssssssssssesssssssanes 9
Step 3: SYNthESIZING the DESIGN..... sttt ss s nees 10
Step 4: Launching the VIVado IDE ...t sse st sssssssssssssssssssssssssssssnses 11
Step 5: Defining Timing Constraints and I/O Planning ... sesessesisseeees 13
Defining TimMING CONSIIAINTS .....c.vveieriirieeeieeie ettt ssse s ss st ss s st ssss s ssesens 13

I/O PlANNING oottt sttt s s ettt 14
Step 6: Exporting the Modified CONSIAINTS .......c.oevrreeeriereerri ettt sassseees 16
Step 7: IMpPIemeNnting the DESIGN.......irieeeeieereeie ettt sss st s st st sssssssssnses 17
Step 8: Opening @ DesigN ChECKPOINT ... ssss s st sssssssnsnses 18
Step 9: Analyzing Implementation RESUILS ...t sssssnees 18
Step 10: EXiting the VIVAd tOOL........ereee sttt st ssssssss s ssnses 21
Lab 2: USiNg the ProjeCt DESIGN FIOW ...ttt sisee e ssssessssessssessssssssssssssssesissssisssissesinecsines 22
SEEP 1: Creating @ PrOJECT ...ttt ees s 22
LAUNCNING VIVAAO ...ttt st sss sttt st e 22
Creating @ NEW PrOJECT ...ttt sttt enaes 23
Step 2: Using the Sources Window and Text EAItOr ... ssesssseenes 27
Design Flows Overview www.xilinx.com 3

UG888 (v2013.3) October 2, 2013 l Send Feedback I


http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=ug888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2013.3&docPage=3

Exploring the Sources Window and Project SUMMAIY ... sessssssssesssessssssssens 28

EXPIOrNG the TEXE EAITON ...ttt sttt st nsens 28
Step 3: Elaborating the RTL DESIGN ...t ssssssssssssssssssssssssssssssssssssssssssssssssssssssssnses 30
Step 4: USING the IP Catalog ..ottt ss s ssse s s ss s ssss s ssnees 31
Step 5: Running Behavioral SIMUIAtION ... ss s sssnees 32
Step 6: Reviewing Design RUN SETHINGS ...ttt ss st ssssnses 33
Step 7: Synthesizing and Implementing the DESIGN ... ieeeseees 35
Step 8: Analyzing the SyntheSized DESIGN ...t sasessees 36
Step 9: Analyzing the Implemented DESIGN ... ss s ssseseees 39

Opening the IMPIEeMENLEA DESIGN........oiieireeie e s st ss st sssssanes 39

ANAIYZING ROULING .ottt bbbttt s s 40
Step 10: Generating @ BitStream filE ... .ottt eees 42
Step 11: Creating a Tcl Script from the Journal File ... 43

Examining the LOG and JOUINAL ...ttt 43

Editing the BatCh ProjECt SCrPt ...ttt ss st ss s sens 45

RuNNing the BatCh Project SCrPT ...ttt sss s 46
Step 12: Checking the DeSIGN SAtUS ...ttt ss s saeeen 47
SUMIMIAIY ottt e bbb bbbt 47

Design Flows Overview 4

UG888 (v2013.3) October 2, 2013 l Send Feedback I


http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=ug888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2013.3&docPage=4

& XILINX.

Vivado Design Flows Tutorial

Design Flows Overview

This tutorial introduces the use models and design flows recommended for use with the Xilinx®
Vivado® Integrated Design Environment (IDE). This tutorial describes the basic steps involved in
taking a small example design from RTL to bitstream, using two different design flows as
explained below. Both flows can take advantage of the Vivado IDE, or be run through batch Tcl
scripts. The Vivado Tcl API provides considerable flexibility and power to help set up and run
your designs, as well as perform analysis and debug.

TIP: You can also learn more about the Vivado Design Suite design flows by viewing the
quick take video at http.//www.xilinx.com/csi/training/vivado/vivado-design-flows-
overview.htm.

Working in Project Mode and Non-Project Mode

Some users prefer the design tool to automatically manage their design flow process and design
data, while some prefer to manage sources and process themselves. The Vivado Design Suite
uses a project file (. xpr) and directory structure to manage the design source files, store the
results of different synthesis and implementation runs, and track the project status through the
design flow. This automated management of the design data, process and status requires a
project infrastructure. For this reason, Xilinx refers to this flow as the Project Mode.

Other users prefer to run the FPGA design process more like a source file compilation; to simply
compile the sources, implement the design, and report the results. This compilation style flow is
referred to as the Non-Project Mode. The Vivado Design Suite easily accommodates both of
these use models.

The following provides a brief overview of Project Mode and Non-Project Mode. For a more
complete description of these design modes, and the features and benefits of each, refer to the
Vivado Design Suite User Guide: Design Flows Overview (UG892).

Non-Project Mode

This use model is for script-based users who do not want Vivado tools to manage their design
data or track design state. The Vivado tools simply read the various source files and compile the
design through the entire flow in-memory. At any stage of the implementation process, you can
generate a variety of reports, run design rule checks (DRCs), and write design checkpoints.
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Throughout the entire flow, you can open the design in-memory, or any saved design
checkpoint, in the Vivado IDE for design analysis or netlist/constraint modification. Source files,
however, are not available for modification in the IDE when running the Non-Project Mode. It is
also important to note that this mode does not enable project-based features such as source file
and run management, cross-probing back to source files, design state reporting, etc. Essentially,
each time a source file is updated on the disk; you must know about it and reload the design.

There are no default reports or intermediate files created within the Non-Project Mode. You
must direct the creation of reports or design checkpoints with Tcl commands.

Project Mode

This use model is for users who want the Vivado tools to manage the entire design process,
including features like source file, constraint and results management, integrated IP design, and
cross probing back to sources. In Project Mode, the Vivado tools create a directory to manage
the design source files, IP data, synthesis and implementation run results and related reports.
The Vivado Design Suite manages and reports the status of the source files, configuration, and
the state of the design. You can create and configure multiple runs to explore constraint or
command options. In the Vivado IDE, you can cross-probe implementation results back to the
RTL source files. You can also script the entire flow with Tcl commands, and open Vivado IDE as
needed.

Using Tcl Commands

The Tcl commands and scripting approach vary depending on the design flow used. When using
the Non-Project Mode, the source files are loaded using read verilog, read vhdl,

read edif, read ip, and read xdc commands. The Vivado Design Suite creates an in-
memory design database, to pass to synthesis, simulation, and implementation. When using
Project Mode, you can use the create project, add files, import files, and

add directories commands to create the project infrastructure needed to manage source
files and track design status. Replace the individual "atomic” commands, synth design,

opt design, place design, route design,andwrite bitstream in the Batch flow,
with an all-inclusive command called 1aunch_runs. The launch runs command groups the
atomic commands together with other commands to generate default reports and track the run
status. The resulting Tcl run scripts for the Project Mode are different from the Non-Project
Mode. This tutorial covers both the Project Mode and Non-Project Mode, as well as the Vivado
IDE.

Many of the analysis features discussed in this tutorial are covered in more detail in other
tutorials. Not every command or command option is represented here. To view the entire list of
Tcl commands provided in the tools, consult the Vivado Design Suite Tcl Command Reference
Guide (UG835).
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This Tutorial contains two labs that can be performed independently.
Lab 1: Using the Non-Project Design Flow

e Walk through a sample run script to implement the bft design.

e View various reports at each step.

e Review the vivado.log file.

e Write design checkpoints.

e Open the Vivado IDE after synthesis to review timing constraint definition and I/O planning
and demonstrate methods to update constraints.

e Open the implemented Design Checkpoint to analyze timing, power, utilization and routing.
Lab 2: Using the Project Based Design Flow

e Create a new Project.

e Walk through implementing the bft design using the Vivado IDE.

e View various reports at each step.

e Open the synthesized design and review timing constraint definition, I/O planning and
design analysis.

e Open the implemented design to analyze timing, power, resource utilization, routing, and
cross-probing.

e Exit and create a Tcl script from vivado.jou file (with launch runs).
e Run the design again using the newly created Tcl script.

e Open the Project in the Vivado IDE, and check that the design status is correct from the
batch run.

Tutorial Design Description

The sample design used throughout this tutorial consists of a small design called bft. There are
several VHDL and Verilog source files in the bft design, as well as a XDC constraints file.

The design targets an xc7k70T device. A small design is used to allow the tutorial to be run with
minimal hardware requirements and to enable timely completion of the tutorial, as well as to
minimize the data size.

Software Requirements

This tutorial requires that the 2013.3 Vivado Design Suite software release or later is installed.
For installation instructions and information, see the Vivado Design Suite User Guide: Release
Notes, Installation, and Licensing (UG973).
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Hardware Requirements

Hardware Requirements

The supported Operating Systems include Redhat 5.6 Linux 64 and 32 bit, and Windows 7, 64
and 32 bit.

Xilinx recommends a minimum of 2 GB of RAM when using the Vivado tool.

Preparing the Tutorial Design Files

You can find the files for this tutorial in the Vivado Design Suite examples directory at the
following location:

e <Vivado_install_area>/Vivado/<version>/examples/Vivado_Tutorial

You can also extract the provided zip file, at any time, to write the tutorial files to your local
directory, or to restore the files to their starting condition.

Extract the zip file contents from the software installation into any write-accessible location.
e <Vivado_install_area>/Vivado/<version>/examples/Vivado_Tutorial.zip
The extracted Vivado_Tutorial directory is referred to as the <Extract_Dir> in this Tutorial.

Note: You will modify the tutorial design data while working through this tutorial. You should
use a new copy of the original Vivado_Tutorial directory each time you start this tutorial.
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Lab 1: Using the Non-Project Design Flow

This lab focuses on Non-Project Mode and the associated Tcl commands.

Step 1: Examine the Example Script

1.

Open the example script, <Extract_Dir>/Vivado_Tutorial/run_bft_batch.tcl, in a text
editor and review the different steps.

STEP#0: Define output directory location.

STEP#1: Setup design sources and constraints.

STEP#2: Run synthesis, write design checkpoint and generate reports.
STEP#3: Run placement and optimization commands, write design checkpoint
and generate reports.

STEP#4: Run routing command, write design checkpoint and generate reports.
STEP#5: Generate a bitstream.

Notice that many of the Tcl commands are commented out. You will run them manually, one
at a time.

Leave the example script open, as you will copy and paste commands from it later in this
tutorial.

Step 2: Starting Vivado with the Example Design

On Linux,

Change to the directory where the lab materials are stored:
cd <Extract Dir>/Vivado Tutorial

Launch the Vivado Design Suite Tcl shell, and source a Tcl script to create the tutorial design:

vivado -mode tcl -source create bft batch.tcl
On Windows,
Launch the Vivado Design Suite Tcl shell:

Start > All Programs > Xilinx Design Tools > Vivado 2013.x >
Vivado 2013.x Tcl Shell'

In the Tcl shell, change to the directory where the lab materials are stored:
Vivado% cd <Extract Dir>/Vivado_Tutorial

! Your Vivado Design Suite installation may called something different than Xilinx Design Tools
on the Start menu.
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Step 3: Synthesizing the Design

3. Source a Tcl script to create the tutorial design:

Vivado% source create bft batch.tcl

After the sourced script has completed, the Vivado Design Suite Tcl shell, hereafter called the Tcl
shell, displays the Tcl prompt: Vivado%

@ Vivado Tl Shell - C:\Xilinx\Vivade\2013.1\\bin\vivado.bat -mode tel = | & |

ello from User’s init.tcl in C:or/Userss<user_IlD>rsAppData-sRoaming-dilinx-Uivado
i proc findCmd {optionr {
it # This returns a list of commands having the specified option
i # Could bhe enhanced to handle multiple options in AND or OR configuration
! foreach cmd [lsort [info commands =11 {
catch {
if {[regexp "Soption" [help —syntax Scmdll> £
puts Scmd

i proc args { cmdMame > {
it # Thiz command returns the short form of the specified command

help $cmdMame —args

ivadox cd GC:rDatasVivado_Tutorial
ivadox source create_hft_hatch.tcl
set outputDir .- Tutorial_Created_Data-bft_output
file mkdir SoutputDir
read_vhdl -library bftLib [ glob ./Sources hdl- bftLibs»*.vhdl 1
i read_vhdl .-Sources hdl-/bft.vhdl
i read verilog [ glob .rSourcesshdl-s*_.uv ]
i read_xdc . Bourcessbft_full.xdc
ts/DatasVivado _TutorialsSourcesshbft_full.xdc
ivadox o

Figure 1: Start Vivado and Source Tcl Script

You can enter additional Tcl commands from the Tcl prompt.

Step 3: Synthesizing the Design

1. Copy and paste the synth_design... command line from the run bft batch.tcl script
into the Tcl shell and wait for synthesis to complete. You can paste into the Tcl shell using
the popup menu, by clicking the right mouse button.

synth design -top bft -part xc7k70tfbg484-2 -flatten rebuilt

Note: The command in the example script is a comment. Do not copy the leading '#
character, or your command will also be interpreted as a comment.

2. Examine the synthesis report as it scrolls by.
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3. When the Vivado Tcl prompt has returned, copy and paste the write_checkpoint,
report_timing_summary, and report_power commands that follow synthesis.

write checkpoint -force SoutputDir/post synth
report timing summary -file SoutputDir/post synth timing summary.rpt
report power -file SoutputDir/post synth power.rpt

4. Open another window to look at the files created in the output directory. On Windows, it
may be easier to use the file browser.
<Extract Dir>/Vivado_ Tutorial/Tutorial Created Data/bft output

5. Use a text editor to open the various report (* . rpt) files that were created.

Step 4: Launching the Vivado IDE

Even though a Vivado project has not been created on disk, the in memory design is available in
the tool, so from the Tcl shell you can open the Vivado IDE to view the design.

Non-Project Mode enables the use of the Vivado IDE at various stages of the design process.
The current netlist and constraints are loaded into memory in the IDE, enabling analysis and
modification. Any changes to the logic or the constraints are live in memory and are passed to
the downstream tools. This is quite a different concept than with the current ISE tools that
require saving and reloading files.

1. Open the IDE using the start_gui command.

Vivado% start gui

-

G Vivado Tel Shell - C:\Xilinx\Vivade\2013.1\\bin\vivado.bat -mode tcl =N = =

IMFO: [Project 1-1111 Unisim Transformation Summary:
Mo Unizim elements were tranzformed.

Phase B | Netlist Checksum: e3e786eb

INFO: [Common 17-831 Releasing license: Synthesis

192 Infos,. 188 Warnings. B Critical Warningsz and 8 Errors encountered.
=ynth_design completed successfully

zynth_design: Time (s»: elapsed = BA:@A3:55 . Memory {(MB>: peak = BB?.185 : gain
= ?59.711

design_1

Uivadox write_checkpoint —force SoutputDir post_synth

Writing HDEF routing.

Writing HDEF routing logical nets.

Writing XDEF routing special nets.

llrite HDEF Conmplete: Time €¢=z): elapsed = B8:80:80.138 . Memory (MB>: peak = #89.
1685 ; gain = 0.080

C-sDatasVivado Tutorial-Tutorial Created_Datarbft_output-spost_synth._.dcp

Uivadox report_timing_summary —file SoutputDir post_synth_timing_summary.rpt
IMFO: [Timing 38-351 Done setting XDC timing constraints.

IMFO: [Timing 38-911 UpdateTimingParams: Speed grade: -2, Delay Type: min_max, C
onstraints type: SDC.

Uivadox puts SoutputDir

./Tutorial_ Created_Data-bft_output

Uivado® report_power —file SoutputDir/post_synth_power.rpt
Running Vector—less Activity Propagation...

Finizhed Running Vector—less Activity Propagation
Vivadox start i

Figure 2: Open the Vivado IDE with start_gui
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Step 4: Launching the Vivado IDE

The Vivado IDE provides design visualization and exploration capabilities for your use. From
the Vivado IDE, you can perform further analysis and constraint manipulation on the design.

4L Vivado 20133

= Mol |
File Edit Flow Teools Window Layout Wiew Help
g2 %] @ @ |3 | LS Timing Analyss - ©

Synthesized Design - xc7k70tfbg484-2

Properties

- Owv x & Device X [
i

) Netlist | & Sources . [} Properties

Timing

No timing reports are available for display. To report timing dick one of the following links:
Check Timing Check the design for possible timing problems.

Report Timing Summary Generate a timing summary to understand if the design met timing.
Report Timing Generate a timing report.

Report Pulse Width

Reports the pulse width of the specified dock signals in the deck netwark and upon reaching the flip-flop.

Report Datasheet Create a datasheet report for the current design, providing the timing characteristics at the 1/0 pads.

[ Td Console Messages | [ Log-, & Timing

Figure 3: Vivado IDE - Non-Project Mode

O TIP: To stop the GUI and return to the Vivado Design Suite Tcl shell, use the stop_gui

command. If you use the File > Exit command from the Vivado IDE, you will completely exit
the Vivado tool.

Since the design does not have a project in Non-Project Mode, the Vivado IDE does not
enable source file or run management. You are effectively analyzing the current in memory

design. The Vivado Flow Navigator and other Project based commands are also not available
in Non-Project Mode.
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Step 5: Defining Timing Constraints and I/O Planning

Step 5: Defining Timing Constraints and 1/0O Planning
You must often define timing and physical constraints for the design prior to implementation.

The Vivado tools let you load constraints from constraints file(s), or enter constraints
interactively using the IDE.

Defining Timing Constraints

1. Open the Timing Constraints window: Window > Timing Constraints.

[ Package x | & Device X | {2 Timing Constraints X O =
E % ,@ Create Clock
) -« || Position Clodk Mame Period (n=) Rige At (ns) Fall At (ns) Add Clock Source Objects Source File
x =3 1 whClk 10,000 ] [get_ports wbClk]  bft_full.xdc
[

.000 = [get_ports bftclk] bft full.xdc

m

et External Delay (0
[=-Inputs (0]

L.set Input Delay (0]
EJ-Outputs (1)

¢ l.Bet Output Delay (0]
[l-Assertions (0]

| i SetData Check (0

¢ -Set Maximum Delay (0 =

All Constraints

[-§ E-HY bft_full. xde (C:/Data/Vivade_Tutorial Sources/bft_full.xdc

= g 1. create_dock -period 10.000 -name whClk [aet_ports whClk]
‘g8 2, create_dock -period 5.000 -name bftClk [get_ports bftclk]

X [l 1R [

Figure 4: Define Timing Constraints

A tree view of the different types of constraints displays on the left side of the Timing
Constraints window. This is a menu of timing constraints that can be quickly defined.

Notice the two clock constraints, wbClk and bftClk, displayed in the Timing Constraint
spreadsheet on the right side of the Timing Constraints window. The values of currently
defined constraints can be modified by directly editing them in the spreadsheet.

2. In the left hand tree view of the Timing Constraints window, Double-click on Create Clock
under the Clocks category, as shown in Figure 4.

Note: Expand the Clocks category if needed by clicking on the “+’.
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The Create Clock wizard opens to help you define clock constraints. Notice the Tcl
Command on the bottom displays the XDC command that will be executed.

Do not create or modify any timing constraints at this time.

é"‘_ Create Clock @

[0', Creates a dock object. The created dock is applied to the specified source objects. If you do not specify
¥ source objects, but give a dock name, a virtual dock is created.

Clock name:
Source objects: |:|
Waveform
Period: 105 ns
Rise at: 05| ns
Fall at: 55 ns

Add this dock to the existing dock (no overwriting)

Command: | create_dock -period 10,000 -waveform {0,000 5,000}

Reference... Reset to Defaults [ OK ] | Cancel

Figure 5: Create Clock Dialog Box

3. Click Cancel.
4. Close the Timing Constraints window by clicking the X in the window tab.

The Vivado Design Suite offers a variety of features for design analysis and constraint
assignment. Other tutorials cover these features in detail, and they are only mentioned here.
Feel free to examine some of the features under the Tools menu.

1/0 Planning
Vivado has a comprehensive set of capabilities for performing and validating I/O pin
assignments. These are covered in greater detail in the I/O Planning Tutorial.

1. Open the I/O Planning view layout by selecting I/0 Planning from the Layout Selector pull
down, as shown in Figure 6.

2. Make the Package window the active view if it is not active.

Note: If the Package window is not open, you can open it using the Windows > Package
command from the main menu.
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In the Package window, double-click to select a placed I/O Port,
shown as an orange block inside a package pin.

Drag the selected I/O Port onto another pin site in the same I/O
bank.

Examine the I/0 Ports window, look at the port name and package
pin site columns.

Examine the data displayed in the I/O Port Properties window.
Click each of the tabs at the bottom of the window.

Remember the port name and site of the port you moved.

Step 5: Defining Timing Constraints and I/O Planning

TO_Do4_14

Write them down if necessary, because you will look for the LOC constraint of the placed

port in the XDC file, after implementation.

- Vivado 20133
File Edit Flow Tools

AEER0@ER

Synthesized Design - xc7k70tfbg484-2

Window Layout View Help
p X | & @ 2|5 | 210 Panning e R ®

B3 Default Layaut
L= 1/0 Planning

folle =

Device Constraints — O %
A < =H[EI@ X
~ Internal VREF
1 0.8V
1 0.675V
10,75V
=3 0.
(-5 NONE (2)
~-gm IfO Bank 13
~go IfO Bank 14

3 Clock Planning
3 Foorplanning
15 Debug

5 Timing Analysis

05 save As New Layout...
Reset Layout

~-gm IfO Bank 15
~-gm IfO Bank 16
“omm /O Bank 33
Lomm TjO Bank 34

Drop 1/0 banks on voltages or the ™NONE™ folder to set/unset
Internal VREF.

£ Sources | [ Netiist- & Device Constraints

Properties - 0O =

+ =)

& Properties | m Clock Regions

1/0 Ports

Name Fixed  Bank

-l Allports (71)
% whInputData (32)
4@ whOutputData (32)
¥ Scalar ports (7)

Direction  Meg Diff Pair Site 1/0 std Veco  Vref  DriveStrength  Slew Type

14 LVCMOS18 ~ 1800
LVCMOS18 - 1.800 12

NONE
~ NONE

Input
Output

- sLow

L & ok ik B P

Pull Type

Off-Chip Termination ~ IN_TERM

~ NONE -
~ FP_VTT_50 -

5 Td Console | () Messages | [ Log | 5 Package Pins, O+ 1/0 Ports

Figure 6: Open 1/0 Planning View Layout
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Step 6: Exporting the Modified Constraints

Modified constraints can be output for later use. You can also save design checkpoints that
include the latest changes. You will explore design checkpoints later in this tutorial.

IMPORTANT: The Vivado Design Suite does not support NCF/UCF constraints. You
i} should migrate existing UCF constraints to XDC format. Refer to the ISE to Vivado
Design Suite Migration Guide (UG911) for more information.

o v ok W

Use the Export Constraints command to output a modified XDC constraints file with the new
I[/O LOC constraint value.

File > Export > Export Constraints

The Export Constraints dialog box opens to let you specify a file name to create.

g'“_ Export Constraints @

,'0‘, Please spedfy file name to export XDC constraints.

Output file name: | C:/Data/constrs_1.xdc |:|

/| Export fixed location constraints only

[ OK ] | Cancel

Figure 7: Export Constraints

Enter a name and location for the file and click OK.

Notice the checkbox for Export fixed location constraints only. When this is enabled, only
the LOC constraints of fixed cells are exported, rather than of all placed cells. For a more
detailed description of fixed versus unfixed cells, refer to the Vivado Design Suite User Guide:
Design Analysis and Closure Techniques (UG906).

Use the File > Open File command to open the constraints file in the Text Editor.
Set the File of type filter at the bottom of the Open File dialog to All Files.
Browse to select the newly exported constraints file and click OK.

Notice the file reflects the I/O Port placement change you made earlier.

You can open any ASCII file in the Text Editor. This is helpful for editing Tcl scripts and
constraints files, and viewing reports. The Text Editor is context sensitive, and highlights
keywords and comments, when displaying file types such as Verilog, VHDL, XDC, and Tcl.

Select the Tcl Console tab at the bottom of the IDE, and enter the stop_gui command.

The Vivado IDE closes, and you are returned to the Tcl prompt in the Tcl shell.
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Step 7: Implementing the Design

1. Open the run_bft_batch.tcl script, or bring it to the front.

2. Individually copy and paste the Tcl commands in the script, in order from opt_design to
write_bitstream:

opt design

place design

phys opt design

write checkpoint -force SoutputDir/post place

report timing summary -file SoutputDir/post place timing summary.rpt
route design

write checkpoint -force SoutputDir/post route

report timing summary -file SoutputDir/post route timing summary.rpt
report timing -sort by group -max paths 100 -path type summary -file
$outputDir/post route timing.rpt

report clock utilization -file SoutputDir/clock util.rpt

report utilization -file SoutputDir/post route util.rpt

report power -file SoutputDir/post route power.rpt

report drc -file SoutputDir/post imp drc.rpt

write verilog -force SoutputDir/bft impl netlist.v

write xdc -no fixed only -force SoutputDir/bft impl.xdc

write bitstream -force SoutputDir/bft.bit

3. Examine each command and notice the various messages produced as the commands are
run.

4. Examine the files created in the output directory.
<Extract Dir>/Vivado_Tutorial/Tutorial Created Data/bft output

5. Use a text editor to open the various report (* . rpt) files that were created.
6. Open the bft_impl.xdc file.

7. Validate that the design has been implemented with the I/O Port constraint that you
modified earlier.
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Step 8: Opening a Design Checkpoint

The Vivado IDE can open any saved design checkpoint. This “snapshot” of the design can be
opened in the Vivado IDE or Tcl shell for synthesis, implementation, and analysis.

1.

Open the Vivado IDE again: start_gui
This loads the active design in-memory into the IDE.

You will now load the implemented design checkpoint, closing the current in-memory
design.

Open the implemented checkpoint.

Use File > Open Checkpoint and browse to select the checkpoint file:

<Extract Dir>/Vivado_Tutorial/Tutorial Created Data/bft output/
post_route.dcp

Select Yes to close the current in-memory design.
If prompted, select Close Without Saving.

Now you can use the visualization and analysis capabilities of the IDE, working from a placed
and routed design checkpoint.

Step 9: Analyzing Implementation Results

Vivado has an extensive set of features to examine the design and device data from a number of
perspectives. You can generate standard reports for power, timing, utilization, clocks, etc. With
the Tcl API, the custom reporting capabilities in the Vivado tools are extensive.

1.

Run the report timing summary command to analyze timing data.

Tools > Timing > Report Timing Summary
In the Report Timing Summary dialog, click OK to accept the default run options.

Examine the information available in the Timing Summary window. Select the various
categories from the tree on the left side of the Timing Summary window and examine the
data displayed.

Now run the report timing command to perform timing analysis

Tools > Timing > Report Timing
In the Report Timing dialog, click OK to accept the default run options.
Select the first path listed in the Timing results window.

Maximize or float the Path Properties window to look at the path details.
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Step 9: Analyzing Implementation Results

Implemented Design - xc7k70tfbg484-2 X
Path Properties —Oe x
k< =
= Path 21
= Summary A
e e
Slack 1.051ns
Source D ingressLoop[4].ingressFifo/buffer_fifofinfer_fi
Destination [ transformLoop[4].ct/xOutReg_reg/C[17]
Path Group bftClk
Path Type Setup

oy
5%
&
=
o

Requirement 5.000ns
Data PathDelay ~ 3.645ns
Logic Levels [
Clock Path Skew  -0.105ns .[‘J’
Clock Uncertainty 0.0350s
I Source Clock Path 53
L Delay Type Delay Exd
(dock btclk rise cdge) ) 0.000 B T
() 0.000 am
net (fo=0) 0.000 ELA L
-t
IBUF (Prop buf T 0) )0.749 it nn
net (fo=1, routed 1501 ~ bF
"
BUFG (Prop_hufg_I_Q) () 0.093 .
net (fo=730, routed) 1.254 B
« m =]
General | Properties | Report | Cells | Options
5] Netiist ) Properties

Timing - Report Timing - timing_2

aQ T B [~ 4 Timing Checks - Setup
" . 1
- 2 General Information b A | Name Slack Levels From To Total Delay Logic Delay Met%  HighFanout Sou
i3 Settings 2| 5. Constrained (2
51 Timing Checks (40 - onstained L5
g
L [ - =
Bt = ] = 4).ctjxOutReg reg/CLi7] IEEE T T
= - £ 1.051 0 ingressLoop[4]..._reg/CLKBW... transformLoop[4].ct/xOutReq_req/C[19] 3.645 1.800 50.6 66 bftc
k4 r 1.051 0 ingressLoop[4]..._reg/CLKBW... transformLoop[4].ct/xOutReg_reg/C[46] 3.545 1.800 50.6 66 bftC
x ra 1.051 0 ingressLoop[4]..._reg/CLKBW... transformLoop[4].ct/xOutReg_reg/C[47] 3.545 1.800 506 66 bftC
| rd 1.062 0 ingressLoop[4]..._reg/CLKBW... transformLoop[4].ct/xOutReg_reg/C[16] 3.634 1.800 50.5 66 bftC
Hl Ca 1,062 0 inaressLoop(4l... rea/CLKBW... transformLoopl4].ct/xOutReq rea/Cl36] 3.634 1,800 50.5 66 bfb:lé‘
| ¢ . ¥
) Timing Summary - timing_1 X | %] Report Timing - timing_2 X PRE]
| Td Console | ) Messages-, & Timing

Figure 8: Maximize the Path Properties Window

7. Restore the Path Properties window by clicking the Restore button, or the Dock button, in
the window banner.

8. In the Timing — Report Timing window, right-click to open the popup menu and select the
Schematic command to open a Schematic window for the selected path.

Note: Alternatively, you can press the F4 function key to open the Schematic window.

9. Double-click on a schematic object, such as on a cell, pin, or wire, to expand the schematic
connections, and traverse the design hierarchy.

10. Close the Schematic window, or click the Device window tab to bring it to the front.

11. In the Device window, check to ensure that the Routing Resources button HI| is enabled to

display the detailed device routing.
Notice the Device window displays and highlights the routing for the selected path.
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i

Figure 9: Displaying the Device Routing

12. Select the Auto Fit Selection button in the Device window toolbar menu to enable the
Vivado IDE to automatically zoom into selected objects.

13. Select some additional paths from the Timing results window.
14. Examine the routing for the selected paths in the Device window.

15. Expand the Tools main menu and examine the available analysis features under the
different sub-menus such as Timing and Report.

16. Run some of the available analysis commands: Report Power, Report Clock Interaction,
Report Clock Networks, Report Utilization, etc.

Many of these Design Analysis features are covered in other Vivado tutorials.
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Step 10: Exiting the Vivado tool

The Vivado tool writes a log file, called vivado.log, and a journal file called vivado. jou into
the directory from which Vivado was launched. The log file is a record of the Tcl commands run
during the design session, and the messages returned by the tool as a result of those
commands. The journal is a record of the Tcl commands run during the session that can be used
as a starting point to create new Tcl scripts.

Exit the Vivado IDE:
1. Select the Tcl Console window tab and type the following: stop_gui
2. Exit Vivado:
Vivado$% exit
3. Examine the Vivado log (vivado. log) file.

On Windows, it may be easier to use the file browser to locate and open the log file. The
location of the Vivado log and journal file will be the directory from which the Vivado tool
was launched, or can be separately configured in the Windows desktop icon. You will
configure this in Lab #2.

In this case, look for the log file at the following location:

<Extract Dir>/Vivado Tutorial/vivado.log?

Notice the log file contains the history and results of all Tcl commands executed during the
Vivado session.

4. Examine the Vivado journal (vivado. jou) file.

On Windows, it may be easier to use the file browser. Look for the journal file at the
following location:

<Extract Dir>/Vivado_Tutorial/vivado.jou
Notice the journal file contains only the Tcl commands executed during the Vivado session,

without the added details recorded in the log file. The journal file is often helpful when
creating Tcl scripts from prior design sessions, as you will see in the next lab.

?The vivado.log and vivado.jou may also be written to $APPDATA%\Xilinx\vivado, or
to your /home directory.
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Lab 2: Using the Project Design Flow

In this lab, you will learn about the Project Mode features for project creation, source file
management, design analysis, constraint definition, and synthesis and implementation run
management.

You will walk through the entire FPGA design flow using an example design, starting in the
Vivado IDE. Then you will examine some of the major features in the IDE. Most of these features
are covered in detail in other tutorials. Finally, you will create a batch run script to implement the
design project and see how easy it is to switch between running Tcl scripts and working in the
Vivado IDE.

Step 1: Creating a Project

Launching Vivado

e On Linu,

1. Change to the directory where the lab materials are stored:
cd <Extract Dir>/Vivado Tutorial

2. Launch the Vivado IDE:
vivado

e On Windows, before clicking the desktop icon to launch the Vivado tool, configure the icon
to indicate where to write the vivado.log and vivado. jou files.

1. Right-click on the Vivado 2013.x Desktop icon and select Properties from the popup menu.

2. Under the Shortcut tab, set the Start in value to the extracted Vivado Tutorial directory, as

shown in Figure 10:
<Extract Dir>/Vivado_Tutorial/

3. Click OK to close the Properties dialog box.
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El vivado Properties

[l

Compatibiity | Securty | Detail

5 I Previous Versions

General | Shortcut | Options I Fol

it | Layout | Colors

vivado

Target type: Windows Batch File

Target location: bin

Target:

CAVivado_Installwivado'bin‘wivado bat

Start in: -/DataMivado Tutoral

Shortcut kkey:  None

Run: l Mormal window - l
Comment:

Open File Location l [ Change Icon... l [ Advanced... l

[ ok || camce | oo

Figure 10: Configuring the Start in Directory

4. Click the Vivado 2013.x Desktop icon to start the Vivado IDE

Creating a New Project

S A T o

Click Next.

Design Flows Overview

Click Next in the New Project wizard.
Specify the Project Name and Location:

Project name: project_bft

UG888 (v2013.3) October 2, 2013

Project Location: <Extract_Dir>/Vivado_Tutorial/Tutorial_Created_Data

Step 1: Creating a Project

After Vivado opens, select Create New Project on the Getting Started page.
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gl":_:. MNew Praject @
Project Name P
Enter a name for your project and specify a directory where the project data files will be stored ‘:':/

Project name: | project_bft
Project location: | C:/Data/Vivado_Tutorial/Tutorial_Created_Data I:l
/| Create project subdirectory

Project will be created at: C:/Data/Vivado_Tutorial [Tutorial_Created_Data/project_bft

| < Back “ Next = Finish Cancel

Figure 11: Create New Project

7. Select RTL Project as the Project Type and click Next.
8. Click Add Files...
a. Browse to <Extract Dir>/Vivado Tutorial/Sources/hdl/

b. Press and hold the Ctrl key, and click to select the following files:
async_fifo.v, bft.vhdl, bft tb.v, FifoBuffer.v

c. Click OK to close the File Browser.

9. Click Add Directories...
a. Select the <Extract_Dir>/Vivado_Tutorial/Sources/hdl/bftLib directory
b. Press Select.

10. Click in the HDL Sources for column for the bft tb.v and change Synthesis and
Simulation to Simulation only, as shown below.

11. Click in the Library column for the bftLib, and manually edit the value to change it from
work to bftLib, as shown in Figure 12.
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é” Mew Project @
Add Sources -
Specify HDL and netlist files, or directories containing HOL and netlist files, to add to your project. Create a new source file on disk ‘:L

and add it to your project. You can also add and create sources later.

Index Mame Library HDL Source For Location
w1 FifoBuffer.v work . Synthesis & Simulation ~ C:/DatafVivado_Tutorial/Sources fhdl
e 2 async_fifo.v work o Synthesis & Simulation  C:fDatafNVivado_Tutorial{Sourcesfhdl
wh 3 bft.vhdl work . Synthesis & Simulation  C:fDataNVivado_Tutorial{Sources fhdl >
W 4 bft_th.w work . Simulation anly ~ C:/DatafVivado_Tutorial/Sources fhdl :
& 5 bftlib bftlib ., Synthesis & Simulation ~ C:/DatafVivado_Tutorial /Sourcesfhdl
£
Add Files... J I Add Directories. .. I I Create File...

[7] Scan and add RTL indude files into project
Copy sources into project
Add sources from subdirectories

Target language: | Verlog - | Simulator language: | Verilog

I < Back ” Next = Finish

Figure 12: Add RTL Sources

12. Enable the check boxes for Copy sources into project, and Add sources from
subdirectories.

13. Set the Target Language to Verilog to define the language of the netlist generated by
Vivado synthesis.

14. Set the Simulator Language to Verilog to define the language required by the logic
simulator.

15. Click Next.

16. Click Next again to skip past the Add Existing IP page, since you will not be adding IP at this
time.

17. On the Add Constraints page, click Add Files...

18. Browse to select <Extract Dir>/Vivado Tutorial/Sources/bft full.xdc.
19. Click OK to close the File Browser.

20. Enable the check box for Copy constraints files into project.

21. Click Next to move to the Default Part page.
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Step 1: Creating a Project

Q:L New Project

Add Constraints (optional)
Spedfy or create constraint files for physical and timing constraints.

B

Constraint File Location

4 bft_full.xdc

C:\Data\Wivado_Tutorial\Sources

Add Files...

] [ Create File...

Copy constraints files into project

[ <Back | MNext> | Finish

Cancel

Figure 13: Add Constraints

22. On the Default Part page, click the Family filter and select the Kintex-7 family

23. Scroll to the top of the list and select the xc7k70tfbg484-2 part, and click Next.

24. Click Finish to close the New Project Summary page, and create the project.

Design Flows Overview
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A:L-. Mew Project @
Default Part .
Choose a default Xilinx part or board for your project. This can be changed later. ':1/
Specify Filter
i Parts Product category | Al - Package | All Remaining -
@ Boards Family | Kintex-7 ~ | Speed grade | All Remaining -
Sub-Family | All Remaining « | Temp grade | All Remaining -
Reset All Filters
Search:
I/O Pin Available LUT ) Block Gh
R Count I0Bs Elements LI RAMs B Transceivers
@ xcTkT0tbg484-3 434 285 41000 82000 135 240 4 -
Tor s oo lewor s w[p
G xc q 454 285 41000 32000 135 240 4
1§ xcTkT0thhg484-1 434 285 41000 82000 135 240 4
@ xcTkT0tfbgs7e-3 a7 300 41000 82000 135 240 8
& xcTkT0thhas75-2 675 300 41000 82000 135 240 8
@ xcTkT0thah75-2L 675 300 41000 32000 135 240 8
@ xcTkF0thbgs7E-1 675 300 41000 82000 135 240 8 -
4| I | r [0
[ < Back ” Next = ] Finish
Figure 14: Selecting the Default Part
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Step 2: Using the Sources Window and Text Editor

The Vivado IDE opens project bft in the default layout.

L=

Flow Navigator

AT =

4 Project Manager
@ Project Settings

5% Add Sources
1F 1P catalog

4 TP Integrator
% Create Block Design
 Open Block Design

& Generate Block Design

4 Simulation
@ Simulation Settings
(i) Run Simulation

4 RTL Analysis
> Eb Open Elaborated Design

4 Synthesis
5 Synthesis Settings
@ Run Synthesis

> [@¥ Open Synthesized Design

4 Implementation
43 Implementation Settings
[» Run Implementation

> @ Open Implemented Design

4 Program and Debug
@ Bitstream Settings
¥ Generate Bitstream
Eb Open Hardware Session

| ') Launch iIMPACT

&«

i:-‘,: project_bft - [C:/Data/Vivade_Tutorial/Tutorial_Created_Data/project_bft/project_bftxpr] - Vivade 2013.2.0
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Synthesis E3 Implementation
Stetus: S Notstarted Status: = Not started
Messages: No errors or warnings Messages: No errors or warnings
Part: xc7k70tfbg484-2 Part: xc7k70tfbg484-2
Strategy:  Vivado Synthesis Defaults Strategy: Vivado Implementation Defaults
Incremental Compile: hone
Hierarchy  Libraries | Compile Order
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Figure 15: Project BFT in the Vivado IDE

Step 2: Using the Sources Window and Text Editor

The Vivado tool lets you add different design sources, including Verilog, VHDL, EDIF, NGC
format cores, SDC, XDC, and TCL constraints files, and simulation test benches. These files can
be sorted in a variety of ways using the tabs at the bottom of the Sources: Hierarchy, Library or

Compile Order.

The Vivado IDE includes a context sensitive text editor to create and develop RTL sources,
constraints files, and Tcl scripts. You can also configure the Vivado IDE to use third party text
editors. Refer to the Vivado Design Suite User Guide: Using the IDE (UG893) for information on
configuring the Vivado tool.
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Exploring the Sources Window and Project Summary
1. Examine the information in the Project Summary. More detailed information is presented as
the design progresses through the design flow.

2. Examine the Sources window and expand the Design Sources, Constraints and Simulation
Sources folders.

Tu
b

Sources - 0O

g ;
N ey = ] Ol#l‘ . E

—z7 Design Sources (1)
_"-"."_':"aaa bft - aBFT (bft.vhdl) (6)
-4l arndl - round_1 - aR1 (round

.}
o]

+Hfl arnd2 - round_2 - aR2 (round_2.vhdl) (8
+\fh arnd3 - round_3 - aR3 (round_3.vhdl) (2
+h4f arnd4 - round_4 - aR4 (round_4.vhd)
+w ingressFifo - FifoBuffer (Fif 1
+-4® eqressFifo - FifoBuffer (FifoBuffer.w) (1)
—H Constraints (1)
=l constrs_1
Y bft_full.xde
== Simulation Sources (1)
=& sim_1 (1)

;----\.f_%'a“a bft_tb (bft_tbh.v) (1)
F-@ uut - bft - aBFT (bft.vhdl) (&)

Hierarchy | Libraries | Compile Order

4h Sources | ' Templates

Figure 16: Viewing Sources

The Design Sources folder helps keep track of VHDL and Verilog source files and libraries.
Notice the Hierarchy tab is displayed by default.

3. Select the Libraries tab and the Compile Order tabs in the Sources window and notice the
different ways that Sources are listed.

The Libraries tab groups source files by file type. The Compile Order tab shows the file order
used for synthesis.

4. Select the Hierarchy tab.

Exploring the Text Editor

1. Select one of the VHDL sources in the Sources window.
2. Right-click to review the commands available in the popup menu.

3. Select Open File, and use the scroll bar to browse the file contents in the Text Editor.
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Step 2: Using the Sources Window and Text Editor

You can also double-click on source files in the Sources window to open them in the Text

Editor.

ER

¥ 11

. Project Summary % | ¢ round_Lwvhdl =
C:/DataVivado_Tutorial/Tutorial_Created_Dataj/project_bft/project_bft.sres/sources_1fimportsfhd/bftlibround_1.vhdl
40 use bftlib.

bftPackage.all;

42entity round_1 is

”&“ 43 port (

= 24 clk: in std logics
fj 45 X : in xType;
13| a6 x0ut : cut xIype
b 4EY -
."l."l 48 end entity round_1;
|49
|50 architecture aRl of round_1 is
CH__J 51 constant u : ulype :=

|52 (¥xro123v,
& 53 K"4567",

Figure 17: Context Sensitive Text Editor

Notice that the Text Editor displays the RTL code with context sensitive coloring of keywords
and comments. The colors and fonts used to display reserved words can be configured using
the Tools > Options command. Refer to the Vivado Design Suite User Guide: Using the IDE

(UG893) for more information.

Replace in Files command.

The Find in Files dialog box opens with various search options.

With the cursor in the Text Editor, right-click and select Find in Files. Notice also, the

g Find in Files

Find what:

o

Options
[] Match case
["] Match whale word

[ Use:

@) Regular Expressions Wildcards

Scope

Enabled design sources (3)

Enabled constraints (1)

Openin a new tab

X5

’ Find Close

|

Design Flows Overview

Figure 18: Using Find in Files
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5.

Enter clk in the Find what: field, and click Find.

Step 3: Elaborating the RTL Design

The Find in Files window displays in the messaging area at the bottom of the Vivado IDE.

Find in Files - 108 occurrences of 'dk' in 9 of 10 project files

A
=
[=5]

(=5
(=]

7.
8.

=] Found usages (105 usages)

clk : in std_logic;

I process (clk)

if rising_edge(clk) then
¢l process (clk)

! ifrising_edge(clk) then

8 C:/DataMivado, TthrlaIﬂ'thnaI Created Daiafproject bf‘t,u’pro_]ect bft.sresfsources_ 1ﬁmportsﬂ1d|fF|f‘oBuffer v

) C ,,'Dam,'\l'lvado _Tutorial/Tutorial_Created_Data/project_bft/project_bft.srcsfsources_1fimportsfhdlfasync_fifo.v (28

er---.\,-'_,-C:fDaE,’\-‘ivado:Tuh}rialfl'ubariaI_Created_Daiafpro_]ect bft,.’prc:]ect bﬁ: srcsfsources lﬂmportsmdlfbﬂ:lberound 3 vhdl &

C:;’Dab,’\-‘wado _Tutorial/Tutorial_Created_Data/project_bft/project_bft.sresfsources_1fimportsfhdl/bftlib/core_transform.vhdl (5 usages)

m

1

108 occurrences of ‘clk’ in 9 of 10 project files x

5 7Td Consale | (O Messages | (5] Log | |2 Reports | (% Design Runs &5 Find in Files

Figure 19: Viewing the Find in Files Results

In the Find in Files window, expand one of the displayed files, and select an occurrence of clk

in the file.

Notice that the Text Editor opens the selected file and displays the selected occurrence of

clk in the file.
Close the Find in Files — Occurrences window.

Close the open Text Editor windows.

The next few steps highlight some of the design configuration and analysis features available
prior to running synthesis.

Step 3: Elaborating the RTL Design

The Vivado IDE includes an RTL analysis and IP customizing environment. There are also several
RTL Design Rule Checks (DRCs) to examine ways to improve performance or power on the RTL

design.

1. Select Open Elaborated Design in the Flow Navigator to elaborate the design.

2. Ensure that the Layout Selector pull down menu in the main Toolbar has Default Layout
selected.
The Elaborated Design enables various analysis views including an RTL Netlist, Schematic,
and Graphical Hierarchy. The views have a "cross-select” feature, which helps you to debug
and optimize the RTL.

3. Explore the logic hierarchy in the RTL Netlist window and examine the Schematic.

You can traverse the schematic by double-clicking on cells to push into the hierarchy, or by
using commands like the Expand Cone or Expand/Collapse from the Schematic popup
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menu. Refer to the Vivado Design Suite User Guide: Using the Vivado IDE (UG893) for more
information on using the Schematic window.

4. Select any logic instance in the Schematic and right-click to select the Go to Source or Go
to Definition commands.

The Text Editor opens the RTL source file for the selected cell with the logic instance
highlighted. In the case of the Go to Definition command, the RTL source file containing
the module definition is opened. With Go to Source, the RTL source containing the instance
of the selected cell is opened.

5. Click on the Messages window at the bottom of the Vivado IDE, and examine the messages.
6. Click the Collapse All button in the Messages toolbar.
7. Expand the Elaborated Design messages.

Notice there are links in the messages to open the RTL source files associated with a
message.

8. Click one of the links and the Text Editor opens the RTL source file with the relevant line
highlighted.

9. Close the Text Editor windows.

10. Close the Elaborated Design by clicking on the X on the right side of the Elaborated Design
window banner and click OK to confirm.

Step 4: Using the IP Catalog

The Xilinx IP Catalog provides access to the Vivado IP configuration and generation features.
You can sort and search the Catalog in a variety of ways. IP can be customized, generated, and
instantiated.

1. Click the IP Catalog button in the Flow Navigator.

2. Browse the IP Catalog and examine the various categories, and IP filtering capabilities.
3. Expand the Basic Elements folder.

4. Double-click on DSP48 Macro

The Customize IP dialog is opened directly within Vivado. The Vivado Design Suite allows
you to perform native customization and configuration of IP within the tool. To learn more
about IP configuration and implementation, see the Vivado Design Suite User Guide:
Designing with IP (UG896) and the Vivado Design Suite Tutorial: Designing with IP (UG939).

5. Click Cancel to close the Customize IP dialog without adding the IP to the current design.

6. Close the IP Catalog tab by clicking on the X on the right side of the window banner.

Design Flows Overview Send Feedback 31
UG888 (v2013.3) October 2, 2013 [—\ /—]


http://www.xilinx.com/cgi-bin/docs/rdoc?v=2013.3;d=ug893-vivado-ide.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?v=2013.3;d=ug896-vivado-ip.pdf
http://www.xilinx.com/cgi-bin/docs/rdoc?v=2013.3;d=ug939-vivado-designing-with-ip-tutorial.pdf
http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=ug888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2013.3&docPage=31

v
i¢ X"—lNX Step 5: Running Behavioral Simulation

Step 5: Running Behavioral Simulation

The Vivado IDE integrates the Vivado Simulator, which enables you to add and manage
simulation sources in the project. You can configure simulation options, and create and manage
simulation source sets. You can run behavioral simulation on RTL sources, prior to synthesis.

1. In the Flow Navigator, under Simulation, click the Simulation Settings command.

gl*" Project Settings @
, 3 : Simulation |
Target simulator: Vivado Simulator -
General
|’.;“_]] Simulator language: Verilog -
Simulation Simulation set: {fmi sim_1 A
§ Simulation top module name: | bft_th I:l
Synthesis | Clean up simulation files
D Compilation | Simulation | Metiist | Advanced
Implementation Verilog options: |:|
1o Generics/Parameters options: |_|
Bitstr
Silstream —debug |typica| |
El = —mt [auto |
» SDF Delay |sdfmax |
= --rangecheck

Enable fast simulation models

Mare Compilation Options

Select an option above to see a description of it

OK | | Cancel Apply

Figure 20: Simulation Settings - Update

2. Examine the settings available under each tab: Compilation, Simulation, Netlist, Advanced;
then Cancel to close the dialog box.

3. Click the Run Simulation command in the Flow Navigator, then click the Run Behavioral
Simulation in the sub-menu.

4. Examine and explore the Simulation environment.

Simulation is covered in detail in the Vivado Design Suite User Guide: Logic Simulation
(UG900) and the Vivado Design Suite Tutorial: Logic Simulation (UG937).

5. Close the Simulation by clicking the X icon on the Simulation view banner.

6. Click No if prompted to save changes.
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Step 6: Reviewing Design Run Settings

Step 6: Reviewing Design Run Settings

One of the main differences between the Non-Project Mode you used in Lab #1, and the Project
Mode which you are now using, is the support of design runs for synthesis and implementation.
Non-Project Mode does not support design runs.

Design runs are a way of configuring and storing the many options available in the different
steps of the synthesis and implementation process. You can configure these options and save
the configurations as strategies to be used in future runs. You can also define Tcl.pre and
Tcl.post scripts to run before and after each step of the process, to generate reports before and
after the design progresses.

Before launching the synthesis and implementation runs you will review the settings and
strategies for these runs.

1. In the Flow Navigator, select Synthesis Settings under Synthesis.

The Project Settings dialog box opens. The Synthesis Settings provides you access to the
many options available for configuring Vivado synthesis. For a complete description of these
options, see the Vivado Design Suite User Guide: Synthesis (UG901).

é‘:‘_:. Project Settings @
. i | Synthesis |
@ Constraints
General
|_]j] Default constraint set: | & constrs_1 (active) -

A
Simulation Options
@ Strategy: A vivado Synthesis Defaults (Vivado Synthesis 2013) - | 0y
Synthesis Description:  Vivado Synthesis Defaults
D =l Synth Design (vivado) -
Implementation tcl.pre
-&’ td.post
e flatten_hierarchy | rebuilt |
Bitstream -gated_dock_conversion |of‘f | 3
_ -bufg 12
=L ~fanout_limit 10,000
P -directive |Defﬁult |
-fsm_extraction | autn |

+eep_equivalent_registers
-resource_sharing W -

Select an option above to see a description of it

| OK | | Cancel Apply

Figure 21: Synthesis Settings
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Step 6: Reviewing Design Run Settings

2. After reviewing the various synthesis options, select the Implementation button on the left
side of the Project Settings dialog box, as shown in Figure 21.

The Project Settings change to reflect the Implementation settings. You will not modify the
Implementation options in this lab., you can view the available options for Implementation
runs. For a complete description of these options, see the Vivado Design Suite User Guide:

Implementation (UG904).

ﬁI” Project Settings

=3

W

General

|f'é' uUE

Simulation

»

Synthesis

>

Implementation
* ]\
1010
a0
Bitstream

P

Implementation

Constraints

Default constraint set: | = constrs_1 (active)
Options
Incremental compile: ||

Strategy: A Vivado Implementation Defaults (Vivado Implementation... -
Description: Vivado Implementation Defaults

=l Opt Design (opt_design)
is_enabled
td.pre
tel.post
-verbose [l

-directive [Default

More Options
=l Power Opt Design (power_opt_design)
is_enabled [
td.pre
£ rnct

Select an option above to see a description of it

1=}

[ ok || cancel

Figure 22: Implementation Settings

3. Click Cancel to close the Project Settings dialog box.

You are now ready to launch Vivado synthesis and implementation.
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Step 7: Synthesizing and Implementing the Design

After configuring the synthesis and implementation run options, you can:

e Use the Run Synthesis command to run only synthesis.

e Use the Run Implementation command, which will first run synthesis if it has not been run,
then run implementation.

e Use the Generate Bitstream command, which will first run synthesis and then run
implementation if they have not been run, then write the bitstream for programming the
Xilinx device.

For this tutorial, we will run these steps one at a time.
1. In the Flow Navigator, click on the Run Synthesis button, and wait for this task to complete.

Notice the progress bar in the upper-right corner of the Vivado IDE, indicating the run is in-
progress. Vivado launches the synthesis engine in a background process to free up the tool
for other actions. While the synthesis process is running in the background, you can
continue browsing Vivado IDE windows, run reports, further evaluate the design. You will
notice that the Log window displays the synthesis log at the bottom of the IDE. This is also
available through the Reports window.

After synthesis has completed, the Synthesis Completed dialog box prompts you to choose
the next step.

Synthesis Completed @

I:o] Synthesis successfully completed.

Open Synthesized Design

View Reports

Don't show this dialog again

| OK || Cancel |

Figure 23: Synthesis Complete

2. Select Run Implementation, and click OK.

The implementation process is launched, and placed into a background process after some
initialization. The next step in this tutorial shows you how you can perform design analysis of
the synthesized design, while you wait for implementation to complete.
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Step 8: Analyzing the Synthesized Design

Opening the synthesized design enables design analysis, timing constraint definition, I/O
planning, floorplanning and debug core insertion. These features are covered in other tutorials,
but you can take a quick look in this step.

1.

© N o U

Select Open Synthesized Design in the Flow Navigator and wait for the design to load.

Notice that as the Vivado IDE opens the synthesized design, the implementation continues
running in the background. At some point while you are exploring the synthesized design,
implementation will complete, and the Implementation Completed dialog box prompts you
to choose the next step.

Implementation Completed @

[o:l Implementation successfully completed.

Mext

@ Dpen Implemented Desigr

Generate Bitstream

View Reports

Don't show this dialog again

| oK || Cancel |

Figure 24: Implementation Complete

Click Cancel to close the dialog without taking any action.

This leaves the synthesized design open. You will open the implemented design after you
are finished examining the features of the synthesized design.

Ensure that the Layout Selector pull down menu in the main Toolbar has Default Layout
selected.

Click the Reports window tab at the bottom of the Vivado IDE.

If the Reports window is not open, you can open it with Windows > Reports.
Double click the Vivado Synthesis Report to examine the report.

Double click the Utilization Report to examine the report.

Close all reports when you have finished examining them.

Click the Messages window tab at the bottom of the Vivado IDE.

If the Messages window is not open, you can open it with Windows > Messages.
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The Messages window provides message type filters in its banner, to display or hide
different types of messages: Errors, Critical Warnings, Warnings, Info, and Status.

9. Click the Collapse All button to condense all of the Messages. =

10. Expand the Synthesis messages.

11. Scroll through the Synthesis messages and notice the links to specific lines within source
files. Click some of the links and notice the source file opens in the Text Editor with the
appropriate line highlighted.

| Synthesized Design - xc7:70tfbg484-2 (active) )(l
Netlist — 0O 2 % I Project Summary X | @ Device X | @i bftwhdl x 0w x
Z _>,‘3:] B C:/Data/Vivado_Tutorial/Tutorial_Created_Data/project_bftfproject_bft.sres/sources_1fimports/fhdl/bft.vhdl
2 bft -~ ) g4 zignal loadEgressFifo : std logic wecter (7 downto 0); -
| Nets (3783) T [ - a5
| Leaf Cells (215) U9 86 3ignal whDataForInputReg : std logic:
arnd1 {round_1) G| a7 -
arnd2 (round_Z) I PR R
- BB --data needs two levels of pipelining.
arnd3 (round_3) S| IV C - R . .
armd4 {round_4) gnal wbInputDataitagel, wbInputDataStagel : std logic wector (31 downto 0):
egressLoop[0].egressFifo (FifoBuffer &) £ 1;3 B
egressLoop[1].egressFifo (FifoBuffer_10) 3| 91lbegin |
egressLoop[2] .egressFifo (FifoBuffer 13} ﬂ 92 i ‘
egressLoop[3].egressFifo (FifoBuffer) | 93--get the data back in sync with the enable 3
egressLoop[4] .egressFifo (FifoBuffer_14) E 3 94 pr;cess (whC1k) i b
egressLoop[5].egressFifo :Fift-Euffer_E'; ,_J 85 begin
egressLoop[6].egressFifo (FifoBuffer_5 — | o
. ) 96 wbInputDataStage0 <= wbInputData;
egressLoop[7].egressFifo (FifoBuffer_: l
ingressLoop[0].ingressFifo (Fifosuffer - a7 wbInputDataStagel <= wbkInputDataStagel;
ingressLoop[1].ingressFifo (FifoBuffer a §/| 98end process;
[#-{T] ingressLoop[2].ingressFifo (FifoBuffer_11) ‘w\ 99
{0 inaress| oonl3LinaressFifo (Fifofuffer 7) o |« 100 --state machine to load data from the WB bus to the input fifes
&b Sources-, [}l Netlist 7| 101process (wbClk)
Source File Properties — O x 2 Lz beglr.]_ L.
103 if rising_edge (wbClk) then
«+BR 104
(@ bft.vhdl 105 if ({reset = '1') then
106 readIngressFifo <="1";
Location: C:,.'Da13Mvado_Tubor\alﬂ'utoria\_Creahed_Dan‘project_; 107 loadState <= 307
Type: L E] |i| 108 wbDataForInputReg <= '0";
109 else
Library: work E] 110 readIngressFifo <="0";
Sige: 10.9KB 111 loadState <= loadNextState;
- . - - hd 112 wbDataForInputReg <= wbDataForInput:
g i oi[=] 113 end if; -
General | Properties 4| I | +
Messages N
A, | ¥] @ 2 critical warnings  [V] () 107 warnings  [¥/] () 288 infos [ (i) 364 status
Z @ [Common 17-201] Sourding tdl script 'C: Ysers\yandyh, XLNXYAppData\Roaming Xilinx Vivadojinit. tcl -
% (@ [Common 17-347] Attempting to get a license for feature 'Synthesis’ andfor device 'xc7k70t =
@ [Common 17-349] Got license for feature 'Synthesis' andjor device 'xc7k70t
D} @ [Synth 8-638] synthesizing module 'bft [bft.vhdl: 57]
{m} RON[synth 8-614] signal 'whInputData' is read in the process but is not in the sensitivity list [bft.vhdl:94]
a -5 [Synth 8-614] signal 'whbInputData5Stagel' is read in the process but s notin the sensitivity list [bft. vhdl:94]
i - [Synth 8-226] default block is never used [bft.vhdl: 127]
i@ [Synth 8-638] synthesizing module 'round_1' [round 1.vhdl:50]
@ [5ynth 8-638] synthesizing module 'coreTransform' [core_transform. vhdl:60
(@ [Synth 8-256] done synthesizing module 'coreTransform’ (1#15) [core_transform. vhdl:60
@ TSunth 8-2561 done sunthesizinn modle 'round 1 (2215) fround_1.vhdl: 501 A
< m | =
|3 Td Console™, = Messages | [ Log | |2 Reports | [% Design Runs | 4§ Find in Files

Figure 25: Synthesis Messages Linked to Source Files

12. In the Flow Navigator, under Synthesized Design, select Report Timing Summary.

The Report Timing Summary dialog box opens. Examine the various fields and options of
this command.

13. Click OK to run with default options.

The Timing Summary Results window opens.
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Timing - Timing Summary - timing_1 — 0O «a X

aQ = \X - @ 4 Design Timing Summary

; >
General Infarmation Setup Hold Pulse Width

----- Timer Settings N . . . . . " o

..... Worst Negative Slack (WNS): 2.415ns Worst Hold Slack (WHS): MA Worst Pulse Width Slack (WPWS): 2.127ns
- Clock Summary (2) Total Negative Slack (TNS):  0.000ns Total Hold Slack (THS): MA Total Pulse Width Negative Slack (TPWS): 0,000 ns
(- Chedk Timing (59) Mumber of Failing Endpoints: 0 Mumber of Failing Endpaints: MA  Mumber of Failing Endpaints: 0
- Intra-Clock Paths Total Number of Endpoints: 8344 Total Number of Endpoints:  MA Total Number of Endpoints: 1468
[#-Inter-Clock Paths
El-Path Groups All user specified timing constraints are met.
[+ User Ignored Paths
[+ Unconstrained Paths

2 Timing Summary - timing_1 X

Figure 26: Report Timing Summary

Examine the Timing Summary Results window showing timing estimates prior to
implementation. Click on some of the reporting categories in the tree on the left side of the
Timing Summary Results window.

14. Select Report Power in the Flow Navigator.

The Report Power dialog box opens. Examine the various fields and options of this
command.

15. Click OK to run with default options.

The Power Results window opens. Examine the Power Results window showing power
estimates prior to implementation. The report is dynamic, with tooltips providing details of
the specific sections of the report when you move the mouse over the report, as shown in

Figure 27.

Click on some of the reporting categories in the tree on the left side of the Power Results
window to examine the different information presented.
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Figure 27: Report Power

16. Close the Report Timing Summary window, the Power Report window, and any open
Text Editor windows.

Step 9: Analyzing the Implemented Design

The Vivado IDE is interactive, enabling editing of design constraints and netlists on the in-
memory design. When you save the design, constraint changes are written back to the original
source XDC files. Alternatively, you can save the changes to a new constraints file to preserve the
original constraints. This flexibility supports exploration of alternate timing and physical
constraints, including floorplanning, while keeping the original source files intact.

Opening the Implemented Design

1. Select Open Implemented Design in the Flow Navigator.
2. Select Yes to close the synthesized design and Don’t Save, if prompted.

After the Implemented Design has loaded, you can see the implementation results in the
Device window.

3. Click on the Reports window tab at the bottom of the Vivado IDE.

If the Reports window is not open, you can open it with Windows > Reports. Select and
examine some of the reports from Place Design and Route Design. Close each of the reports
when you are done.

4. Select the Messages window tab at the bottom of the IDE.

If the Reports window is not open, you can open it with Windows > Messages.
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5. Click the Collapse All button to condense all of the Messages. =
6. Expand the Implementation folder

View the messages from Design Initialization, Opt_Design, Place_Design, and Route_Design.
Analyzing Routing

After the design has been placed and routed, you can generate a timing report to verify that all
the timing constraints are met. You can select paths from the Timing Report window to examine
the routed path in the Device window. If there are timing problems, you can revisit the RTL
source files or design constraints to address any problems.

1. In the Device window, select the Routing Resources button &4| o display the device
routing.

This lets you see the routed connection in the Device window. Though you will need to
zoom closely into the device to see elements of the route, a zoomed-out view lets you see
the route in its entirety.

2. Select the Auto Fit Selection button L in the Device window toolbar menu to enable the
Vivado IDE to automatically zoom into and center the selected objects.

3. In the Flow Navigator, under Implemented Design, click on the Report Timing Summary
button.

4. Click OK in the Report Summary Timing dialog to generate the default report.

5. On the left side pane of the Timing Summary Results window, select:
Intra-Clock Paths > bftClk > SETUP...

In the table view on the right side of the Timing Summary Report window, click on any
timing path to select it and highlight it in the Device window. Select various paths in the
Timing Summary window and examine the path routing.

6. On the left side pane of the Timing Summary Results window, select:
Intra-Clock Paths > bftClk > HOLD...

Click on any path in the table view on the right side of the Timing Summary Results window
to select it and highlight it in the Device window. Select various paths in the Timing
Summary Results window and examine the path routing.
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Figure 28: Examine Routing for Timing Paths

7. With a timing path selected, right-click to open the popup menu in either the Device view or
the Timing Summary window, and select the Schematic command

Note: Alternatively, you can press the F4 function key to open the Schematic window.

The Schematic window opens, displaying the schematic for the selected timing path. Use
commands from the popup menu in the Schematic window, such as Expand or Collapse
Outside, or Expand Cone, to traverse the schematic and examine the logic cells on the timing
path.

8. Close the Schematic window.

9. In the Device window, select the Routing Resources toolbar button again to turn off routing
resources.

The Device window now displays just the placed instances, without the added details of the
routed connections.
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Step 10: Generating a Bitstream file

With IOSTANDARDs constraints defined for all of the I/O ports, and the logic of the design
placed with assigned LOCs, you can generate a bitstream. Before launching Write Bitstream, you
will review the settings for this command.

1. In the Flow Navigator, select Bitstream Settings under Program and Debug.

The Project Settings dialog box opens. The Bitstream Settings provides you access to the
options available for the write_bitstream command. For a complete description of these
options and how to use them, see the Vivado Design Suite User Guide: Programming and

Debugging (UG908).

éff_=. Project Settings

X5

General

(@

©

Simulation

\4

Synthesis

entation

E]

Impled

|a__l{‘?'

Bitstream

U

Bitstream

=| Write Bitstream (write_bitstream)
td.pre
td.post
-raw_bitfile
-mask_file
-no_binary_bitfile
-bin_file
dogic_location_file
More Options

Select an option above to see a description of it

| | Cancel

Figure 29: Bitstream Settings

2. Click Cancel to close the Project Settings dialog box.

3. In the Flow Navigator, under the Program and Debug section, click on the Generate

Bitstream button.

4. After the bitstream has been generated, click OK in the Bitstream Generation Completed
dialog box to view the reports from the command.
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Step 11: Creating a Tcl Script from the Journal File

Running in batch mode is faster and takes less memory than running in the Vivado IDE. When
you need multiple runs to complete a design, it is a good idea to use a Tcl script to automate
the flow. You can also add report generation commands into the script after key steps, and
redirect the output to specific files and directories.

Vivado creates two files as it runs:

e The Vivado tools log (vivado. 1og) file contains the history and results of all Tcl commands
executed during the Vivado session.

e The Vivado tools journal (vivado. jou) file contains only the Tcl commands executed
during the Vivado session, without the added details recorded in the log file.

These files are a great way to learn the Tcl commands used by the Vivado tools to perform
different design tasks. The Vivado journal is also a great source of help when creating a new Tcl
script. Using the vivado. jou file from a completed design flow, you can see all of the Tcl
commands needed to complete the design. Refer to the Vivado Design Suite Tcl Command
Reference Guide (UG835) for a complete description of the Tcl commands and their options.

Examining the Log and Journal

In this step you manually create a Tcl script from the journal file that the Vivado tools
automatically created as you worked from Step 1 through Step 10 of this lab. When you execute
the new script, it will create a project file (. xpr) and directory structure just as you did when you
worked through these steps using the Vivado IDE. If you load this project into the Vivado IDE,
you will see all the results and project status displayed, as you would expect.

1. Select File > Exit, or type exit in the Tcl command line.
2. Click OK to close the Vivado tool.

3. Examine the Vivado log (vivado. 1og) file. On Windows, it may be easier to use the file
browser.

<Extract Dir>/Vivado_Tutorial/vivado.log

Note: This is the location you entered for the Start-in property in Step 1, Launching Vivado,
of Lab #2.

4. Examine the contents and close the file.
5. Open up vivado.jou file in a text editor.

6. Examine the Vivado journal file. On Windows, it may be easier to use the file browser.

<Extract Dir>/Vivado_Tutorial/vivado.jou

You should see something similar to Figure 30, with different file paths:
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¥

¥ Process ID: 10736

¥ Log file: C:/Data/Vivado_Tutorial/vivadeo.log

¥ Journal file: C:/Data/Vivado_Tutorial\vivado.jou

¥
source "C:/Users/xz=zx/AppData/Roaming/¥ilinx/Vivado/init.tcl"

start_gui

create_project project_bft C:/Data/Vivado Tutorial/Tutorial_ Created Data/project_bft —part xcTk70tfbg484-2

set property simulator language Verilog [current project]

add files {C:/Data/Vivado Tutorial/Sources/hdl/bft.vhdl C:/Data/Vivado_Tutorial/Sources/hdl/async fifo.w
C:/Data/Vivado Tutorial/Sources/hdl/FifoBuffer.v}

add files -fileset sim 1 C:/Data/Vivado_Tutorial/Sources/hdl/bft_tb.v

add_files C:/Data/Vivado_ Tutorial/Sources/hdl/bftLib

set_property library bftLib [get_files {C:/Data/Vivado Tutorial/Sources/hdl/bftLib/round 4.vhdl

C:/Data/Vivado Tutorial/Sources/hdl/bftLib/round 3.vhdl C:/Data/Vivado Tutorial/Sources/hdl/bftLib/round 2.vhdl
C:/Data/Vivado Tutorial/Sources/hdl/bftLib/round 1.vhdl C:/Data/Vivado_ Tutorial/Sources/hdl/bftLib/core_transform.vhdl
C:/Data/Vivado_Tutorial/Sources/hdl/bftLib/bft_package.vhdl}]

import files —force

import files -fileset constrs_1 -force —norecurse C:/Data/Vivado Tutorial/Sources/bft_full.xdc

update_compile order —-fileset sources_1

update_compile_order —fileset sources_1

update_compile_order —fileset sim 1

synth _design -rtl -name rtl 1

close_design

launch_xsim —-simset sim_1 -mode behavioral

close_sim

launch runs synth 1

wait_on_run synth 1

launch runs impl 1

wait_on_run impl_1

open_run synth_1 —name netlist_1

report_timing summary —delay type min max -report_unconstrained —check timing verbose —max paths 10 —input_pins -name timing 1
report_power -results {power_ 1}

close_design

open_run impl_1

report timing summary —delay type min max -report unconstrained —check timing verbose -max paths 10 -input pins -name timing 1
launch runs impl 1 -to_step write_ bitstream

wait_on run impl 1

Figure 30: Vivado Journal for Lab #2

7. Remove the comment header (lines starting with #) as unnecessary,

8. Remove any line sourcing the init.tcl script, which runs when the tool is launched.

9. Remove the start_gui line, since there is no need to open the Vivado IDE in a batch script.
10. Use the Save As command to save the file to <Extract Dir>/Vivado Tutorial/run_bft.tcl.

11. With the run_bft.tcl script opened, search and replace all occurrences of “project_bft" with
"project_bft_batch".

12. Examine the script and notice the differences in this Project Mode script from the Non-
Project mode script used in Lab #1 of this Tutorial.

You should take note of the add files and set property commands used for project
creation, as well as the commands to set up the constraints sets. You should also notice that
launch runs is used instead of synth design, etc. Use the launch runs command
when creating or running Project based designs.

CAUTION! Mixing the individual commands (synth design, opt design..) with
launch_runs could damage the Project, and is not recommended. The launch _runs

& command has Tcl options to run steps independently, and create intermediate reports. See the
Vivado Design Suite Tcl Command Reference Guide (UG835) for more information.
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Editing the Batch Project Script

If you did not complete Lab #2 of the tutorial in one design session, your vivado. jou file will
not reflect the complete design flow from step 1 through step 12. In this case, you can use the
run_bft project.tcl script which can be found in the Vivado Tutorial directory.

The first lines of the run bft.tcl script create the design project and specify the target Xilinx
part; add the source RTL and XDC files; and define the VHDL library. The script creates synthesis
and implementation runs, synth_1 and impl_1, and defines the constraint set, constrs_1.

The next few lines elaborate the RTL design and simulate it. You don’t need to do that in the
batch flow.

1.

Add the —force option to the create_project command to over write an existing
project, so that you can run the script multiple times if necessary.

Remove the following lines from your script by deleting the lines, or inserting the '#' symbol
to make the lines comments in the Tcl script:

#synth design -rtl -name rtl 1

#close_design

#launch xsim -simset sim 1 -mode behavioral
#close_sim

In the previous steps in this tutorial, you ran synthesis and implementation, and analyzed the
synthesized design while implementation was running. In the batch flow, you will run
synthesis, then run the timing and power reports, and then run implementation. You need to
reorder the Tcl commands in the scrip to accomplish this. Cut the open_run command, and
the next three lines and move them up to follow the wait on run synth 1 command.

Cut the following lines:

open_run synth 1..
report timing summary..
report power..

Paste them after the wait_on_run synth_1... line.

Now the script launches synthesis, waits for synthesis to complete. Then launches
implementation and waits for implementation to complete. Finally, the script should launch
write bitstreamand wait for it to complete.

Remove the close_design line if one is in the file.
Save the file.

Your file should now look like Figure 31:

Design Flows Overview Send Feedback 45
UG888 (v2013.3) October 2, 2013 [—\ /—]


http://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=ug888&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Design%20Flows%20Overview&releaseVersion=2013.3&docPage=45

v
i. X"—l NX Step 11: Creating a Tcl Script from the Journal File

create_project project_bft batch C:/Data/Vivade Tuteorial/Tutorial Created Data/project_bft batch -part xcTk70tfbg484-2 -force
set_property simulator_language Verilog [current_project]

add_files {C:/Data/Vivado_Tutorial/Sources/hdl/bft.vhdl C:/Data/Vivado_Tutorial/Sources/hdl/async_fifo.v
C:/Data/Vivado_Tutorial/Sources/hdl/FifcBuffer.v}

add_files -fileset sim 1 C:/Data/Vivado_Tutorial/Sources/hdl/bft_tb.v

add files C:/Data/Vivado Tutorial/Sources/hdl/bftLib

set_property library bftLib [get_files {C:/Data/Vivado_ Tutorial/Sources/hdl/bftLib/round 4.vhdl
C:/Data/Vivado_Tutorial/Sources/hdl/bftLib/round 3.vhdl C:/Data/Vivado_Tutorial/Socurces/hdl/bftLib/round_2.vhdl
C:/Data/Vivado_ Tuteorial/Sources/hdl/bftLib/round 1.vhdl C:/Data/Vivadeo_ Tutorial/Scurces/hdl/bftlib/core_transform.vhdl
C:/Data/Vivado Tutorial/Sources/hdl/bftLib/bft package.vhdl}]

import_files -force

import_files -fileset constrs_1 -force -norecurse C:/Data/Vivadeo Tutorial/Scurces/bft_full.xzde

update_compile_order —fileset sources_1

update_compile_order -fileset sources_1

update_compile_order -fileset sim 1

launch_runs synth_ 1

wait_on_run synth 1

cpen_run synth 1 —name netlist 1

report_timing summary -delay type min _max -report_unconstrained -check timing verbose -max paths 10 -input_pins -name timing 1
report_power -results {power 1}

launch runs impl 1

wait_on_run impl_1

open_run impl 1

report_timing_ summary —delay_ type min_max —report_unconstrained —check_timing verbose —max paths 10 —input_pins —name timing_ 1
launch_runs impl_1 -to_step write_bitstream

wait_on run impl 1

Figure 31: Edited Tcl Script

Running the Batch Project Script

You can now execute your new TCL script, running Vivado tools in batch mode, which will run all
the commands in your Tcl script and then quit Vivado when finished.

1. On Windows, open a Command Prompt window. On Linux, simply skip ahead to step 3.
2. Change directory to the Xilinx installation area, and run the settings32.bat or
settings64.bat as needed to setup the Xilinx tool paths for your computer:

cd <Vivado install area>/Vivado/2013.x
settings64

The settings64.bat file configures the path and environment on your computer to run the
Vivado tools.

3. Change directory to <Extract_Dir>/Vivado_Tutorial, and launch the Vivado tool in batch
mode:

cd <Extract Dir>/Vivado Tutorial
vivado -mode batch -source run bft.tcl

4. Examine the Vivado log output, as it is transcripted to the Command Prompt window.

Since the launch runs command is used, less information is echoed to the tool transcript.
Reports and run status are also gathered in the Project and will be available after the run
completes.

Because you ran the Vivado tool in batch mode, it exits after the sourced script has
completed running.
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Step 12: Checking the Design Status

1. Launch Vivado IDE and open the BFT batch project (project bft batch.xpr) that you
just created:

Start > All Programs > Xilinx Design Tools > Vivado 2013.x > Vivado 2013.x?

As an alternative, you can launch the Vivado IDE from the command line:

> cd <Extract_Dir>/Vivado_Tutoria1/ Tutorial Created Data
> vivado -mode gui

The Vivado IDE will launch.
2. Open the project with File > Open Project, and locate project_bft_batch.

As you can see in the project status bar in the upper right of the Vivado IDE, the status
reflects the fact that a bitstream has been generated (write_bitstream Complete).

3. View the implemented design by clicking the Open Implemented Design button in the
Flow Navigator.

4. Quit the Vivado tool when you are finished. This concludes the tutorial.
File > Exit

Summary

After completing this tutorial, you should have learned the following:

e The use of Project Mode and Non-Project Mode.

e Creating an RTL project in the Vivado IDE.

e Configuring the Vivado synthesis, simulation and implementation tools.
¢ Launching the Vivado simulator, synthesis and implementation.

e Applying constraints to the synthesized design.

e Generating timing and power reports.

e Examining routing results in the Device editor.

e Generating a bitstream file.

e Using a Journal file (. jou) to create a project based Tcl script.

e Launching a project based Tcl script from the command line.

e Switching between the Vivado Design Suite Tcl shell and the Vivado IDE.

* Your Vivado Design Suite installation may called something different than Xilinx Design Tools
on the Start menu.
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